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1 INFORMAZIONI GENERALI

Caro Cliente,
La ringraziamo per I'acquisto di questo prodotto.

Il presente documento vuole essere una semplice guida rapida che le permettera una rapida messa in funzione dei
seguenti modelli di unita di ripresa IP di URMET S.p.A Sch. 1093/143M2 - Sch. 1099/204.

Prima di usare I'apparecchiatura, leggere la presente guida rapida che ne descrive 'uso corretto e sicuro.

Conservare questo documento con attenzione ed in un luogo facilmente reperibile per poterlo consultare prontamente
quando necessario.

1.1 AVVERTENZE
Alimentazione

» Prima di collegare I'apparecchio alla rete di alimentazione accertarsi che i dati di targa siano rispondenti a quelli
della rete di distribuzione.

» E' opportuno prevedere a monte degli apparecchi un idoneo interruttore di sezionamento e di protezione.

» In caso di guasto e/o cattivo funzionamento togliere I'alimentazione tramite l'interruttore generale.

»  Utilizzare unicamente I'alimentatore fornito a corredo del prodotto

Precauzioni per la sicurezza

» Per prevenire il rischio di incendio e folgorazione evitare di esporre il dispositivo alla pioggia o all'umidita e di
introdurre al suo qualsiasi oggetto solido o liquido. Se cid dovesse avvenire scollegare il dispositivo dalla rete di
alimentazione e farlo controllare da personale qualificato.

» In nessun caso il dispositivo deve essere aperto. Per qualsiasi intervento di riparazione rivolgersi a personale
qualificato oppure contattare il centro assistenza tecnico autorizzato.

» Conservare questa apparecchiatura lontano dalla portata dei bambini; in caso contrario questi potrebbero
danneggiarla, o danneggiarla accidentalmente.

» Non toccare questa apparecchiatura con le mani bagnate per evitare scosse elettriche o danni meccanici.

» Se I'apparecchiatura dovesse cadere o il contenitore esterno dovesse risultare danneggiato, cessarne I'utilizzo.
Se si continuasse ad utilizzarla in queste condizioni, potrebbe essere provocata una scossa elettrica. In questo
caso contattare il rivenditore, o l'installatore autorizzato.

Precauzioni per l'installazione

» Non installare la telecamera in ambienti esposti alla pioggia o all'umidita. In questi casi utilizzare le apposite
custodie.

» Evitare di puntare direttamente I'obiettivo contro il sole o contro luci intense, anche se la telecamera & spenta; il
soggetto da riprendere non deve essere in controluce.

» Evitare di puntare la telecamera verso oggetti riflettenti.

» La presenza di alcuni tipi di luce (ad esempio fluorescente colorata) puo falsare i colori.

»  Usare I'obiettivo AUTO-IRIS in condizioni di luce variabile.

» Non posizionare questa apparecchiatura su alcuna superficie instabile come un tavolo traballante o inclinato. In
caso contrario I'apparecchiatura potrebbe cadere con conseguenti lesioni o0 guasti meccanici.

» Se allinterno dell’apparecchiatura dovesse penetrare acqua o qualche altro materiale estraneo cessarne
I'utilizzo al fine di evitare la possibilita di incendio e scosse elettriche. In questo caso contattare il rivenditore, o
l'installatore autorizzato.

» Non coprire I'apparecchiatura con un panno quando sta funzionando per evitare deformazioni del contenitore
esterno e surriscaldamento delle parti interne con conseguente possibilita di incendio, scosse elettriche o
guasto meccanico.

» Non avvicinare magneti od oggetti magnetizzati al dispositivo in quanto cid potrebbe causare anomalie di
funzionamento.

» Non usare questa apparecchiatura in ambienti con presenza di fumo, vapore, umidita, polvere, o vibrazioni
intense.

» Non mettere in funzione il dispositivo immediatamente dopo il trasporto da un luogo freddo ad un luogo caldo e
viceversa. Attendere mediamente tre ore: questo intervallo di tempo & necessario al dispositivo per adattarsi al
nuovo ambiente (temperatura, umidita, ecc... ).

Precauzioni d’'uso

»  Assicurarsi dell'integrita dell’apparecchio dopo averlo tolto dall'imballo.

» Controllare che la temperatura d’esercizio sia nei limiti indicati e che I'ambiente non sia particolarmente umido.

» Evitare di puntare la telecamera contro il sole per non danneggiare il sensore.

Pulizia del dispositivo

» Usare un panno asciutto e strofinare leggermente per eliminare polvere e sporcizia.

» Nel caso in cui la sporcizia non fosse eliminabile con un panno asciutto, compiere I'operazione con un panno
inumidito con detergente neutro.

» Non usare prodotti spray per la pulizia dell’apparecchio. Non usare liquidi volatili come benzina, alcool, solventi
ecc. o panni trattati chimicamente per pulire il dispositivo al fine di evitare deformazioni, deterioramenti o graffi
della finitura della vernice.

» Prima di effettuare qualsiasi operazione di pulizia o di manutenzione disinserire I'apparecchio dalla rete di

alimentazione elettrica.
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Registrazioni immagini

» Questa apparecchiatura non & progettata come antifurto ma principalmente per trasmettere ed eventualmente
per registrare immagini. Percid, qualora I'utilizzatore subisca un furto, la societda URMET S.p.A. non puo essere
considerata responsabile di alcuna perdita 0 danno conseguente.

» Effettuare una registrazione di prova prima di utilizzare I'apparecchiatura per verificare che I'operazione
avvenga correttamente. Tenere in considerazione che se I'utente subisce qualche perdita o danno a causa di
errata impostazione di  osservazione, utilizzo, funzionamento improprio o malfunzionamento
dell’apparecchiatura, la societa URMET S.p.A. non puo essere considerata responsabile per I'eventuale perdita
di dati memorizzati.

» Questa apparecchiatura contiene componenti elettronici di precisione. Per garantire la registrazione corretta
delle immagini, non sottoporla ad urti o colpi durante tale operazione.

Privacy e Copyright

> La telecamera IP & un dispositivo per sistemi TVCC. La registrazione delle immagini & subordinata alle leggi
vigenti nel paese di utilizzo. E inoltre vietata la registrazione di immagini protette da Copyright.

»  Gli utenti del prodotto sono responsabili per il controllo ed il rispetto di tutte le norme e gli statuti locali relativi al
monitoraggio e alla registrazione di segnali video. Il produttore NON potra essere ritenuto responsabile per un
utilizzo di questo prodotto che non sia in conformita con le norme in vigore. Per maggiori informazioni
consultare I'indirizzo web http://www.garanteprivacy.it.

Aggiornamento firmware

Si consiglia di consultare periodicamente I'’Area Tecnica Servizio Clienti di URMET SpA al fine di verificare la
disponibilita di eventuali aggiornamenti firmware.

\

Configurazione di rete

> La telecamera & impostata in modalita DHCP. Se la rete in cui va installata non supporta I'indirizzamento
dinamico (DHCP), la telecamera attiva automaticamente I'indirizzo IP di fabbrica 192.168.1.168. Utilizzando il

software Urmet “Easy Tool’ € possibile modificare tale I'indirizzo IP di fabbrica e le altre configurazioni di rete
della telecamera in modo che quest’ultima non crei conflitti con altri dispositivi in rete.

Connessioni di rete

> Quando si effettua una connessione con un pc remoto (mediante Software Client o Browser) occorre tenere in
considerazione che a qualunque canale video utilizzato sul PC corrisponde una connessione di tipo “unicast”
(TCP, RTP, UDP).

> Il dispositivo & in grado di supportare fino a 5 connessioni “unicast”, ovvero & possibile visualizzare il flusso
video da un massimo di 5 postazioni (pc o smartphone) remote in contemporanea, compatibilmente con la
banda disponibile.

INSTALLAZIONE SCH. 1093/143M2

Prima d'iniziare l'installazione, assicurarsi che tutte le unita da collegare non siano alimentate.

Posizionare la staffa in modo tale da riprendere le immagini prescelte, quindi procedere con il fissaggio della staffa sul muro o su
un’altra superficie piana.

Collegare il cavo di rete LAN dal connettore della Telecamera IP allo switch di rete o PC.

Alimentare la telecamera.

INSTALLAZIONE SCH. 1099/204

Prima d’iniziare I'installazione, assicurarsi che tutte le unita da collegare non siano alimentate.

Scegliere la posizione piu idonea per il dispositivo per riprendere le immagini prescelte (la telecamera € posizionata all'interno del
rivelatore e le immagini vengono riprese per mezzo del piccolo foro presente sulla parte frontale).

Una volta stabilito il posizionamento, rimuovere il coperchio del rivelatore svitando la vite posta sotto il rivelatore e premere sul
dente di tenuta.

Utilizzare le incisioni presenti sulla parte interna dell'involucro per fissare il dispositivo, eseguendo su ognuna di esse un foro di
dimensioni adeguate al tipo di ancoraggio utilizzato.

Una volta fissato saldamente il dispositivo alla superficie d’appoggio, riunire le due parti ponendo attenzione a far scattare il perno
precedentemente utilizzato per I'apertura e riavvitando la vite.

Collegare il cavo di rete LAN dal connettore della Telecamera IP allo switch di rete o PC.

Alimentare la telecamera.
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4 CONFIGURAZIONI IP DELL’'UNITA DI RIPRESA

Dopo aver alimentato la telecamera € necessario configurarla sulla propria rete di casa o ufficio.
In caso vi siano piu telecamere da installare sulla stessa rete, si consiglia di installare e configurare una telecamera alla
volta.

4.1 CONNESSIONE SU RETE IP CON SERVIZIO DHCP

Per l'installazione rapida della telecamera su rete con servizio di indirizzamento automatico (DHCP), sara assegnato
automaticamente un indirizzo IP alla telecamera IP. Qualora non fosse provvista di indirizzamento automatico (DHCP)
l'indirizzo IP statico di default sara 192.168.1.168.

Seguono i passi necessari per la prima installazione della Telecamera IP:
Installare il Software “Easy Tool’ fornito in dotazione sul CD a corredo e seguire le istruzioni visualizzate a
Monitor.

]

2. Lanciare il Software “Easy Tool’, selezionando 'ﬁ' EasyTool.exe verranno visualizzati automaticamente
I'indirizzo IP, la subnet mask, il gateway e I'indirizzo MAC di ogni telecamera IP attiva nella LAN corrente, come
mostrato nella figura seguente. Per poter visualizzare la versione Firmware & necessario inserire correttamente
username e password.

EasyTool - olEl

Usemame: | admin Password: | sesss Login Mok MmR  Mpc  EPp

O hu... Device Type MAC » Submask Gateway Crannel  Frmvare Verson_ Devie staws | o0
1 Urmet PC 1080 23:34 192168111  255.255.255.0  192.168.1.1 1 1.1.620151130 No Action fntetiaceli sty
2 Urmet PC 1080P 43A7 102168.113  255.255255.0  102.168.1.1 1 11620151130 No Action e 0. 0.0 .0
3 Urmet IPC 1080P 75:C0 192.168.1.194  255.255.255.0  192.168.1.1 1 1.1,620151130 No Action

submask [0 . 0 .0
Gateway [ 0 . 0 .0 .0
[¥]use the Submask and Gateway of PC

Modiy Network
Reboot
Restore to defauft
Restore Network Configure
Upgrade

Sync Tme

Refresh List

< >

Right-click to select the video preview, open the browser operation!

Se l'indirizzo IP cercato e l'indirizzo IP del PC non sono nello stessa rete, I'utente pud modificare I'indirizzo IP,
la subnet mask e altri parametri della telecamera IP utilizzando il software Easy Tool.

Selezionare inizialmente il dispositivo per modificare I'indirizzo IP e successivamente inserire il nuovo indirizzo
IP, la sbnet mask, il gateway (subnet mask e gateway possono essere ereditati dal pc) e username/password.
Premere su Modifica Network per cambiare l'indirizzo IP del dispositivo.

%NOTA BENE
L’indirizzo IP statico di default della Telecamera IP ¢ “192.168.1.168”, lo username di default € “admin”, e la
password di default & “admin”, il numero di media port € “6066” e la porta di comando & “6060”.

3. Dopo aver rilevato la Telecamera IP premere il pulsante destro del mouse e selezionare “open in IE”, verra
aperta una pagina Web su IE.
Se venisse richiesta linstallazione di un componente ActiveX, verificare che cido avvenga nelle seguenti
modalita.
Prima di effettuare la connessione col PC occorre procedere con la configurazione di protezione di IE
attenendosi alla seguente procedura:

> Dal Menu di Internet Explorer selezionare Strumenti -> Opzioni Internet -> Sicurezza o Protezione
(in base alle versioni di Internet Explorer)

>  Apparira la schermata di “Proprieta — Protezione Internet”. Selezionare I'area “Siti attendibili”.
Cliccare sulla voce “Siti...”.

>  Aggiungere lindirizzo IP del dispositivo nel campo “Aggiungi il sito web all’area” e cliccare sul
pulsante “Aggiungi”.

%NOTA BENE
Non selezionare la voce “Richiedi verifica server (https:) per tutti i siti dell’area”.

> Cliccare su “OK” o “Chiudi”.

> Selezionare “Livello Personalizzato” e verificare che le voci:
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6.

“Inizializza ed esegui script controlli Active X non contrassegnati come sicuri’ sia
selezionata su “Attiva” o “Chiedi Conferma”

“Scarica controlli Active X senza firma elettronica’ sia selezionata su “Attiva” o

“Chiedi Conferma”

>  Confermare ripetutamente premendo su “OK” ed uscire dalla modalita di Opzioni Internet.

> Procedere con I'installazione dell’Ac

%NOTA BENE

tive X da Internet Explorer.

i ﬂml Security Settings - Internet Zone X

General | Securkty | privacy || Content | Connections | Programs | Advanced

Select 3 z0ne taview or change securky settings.
3 v ®

Intermet  Localintranet Trustedsites  Restricted

Internet
This zome s for Intermet websies,
except those listed in trusted and
vestricted zones,

Securicy level for this zone

Custom
Custom settings.
- To change the sektings, clck Custom level,
- To use the recommended settings, click Default level,

Custom level, . Default level
Reset all zones ko default level

Settings

§_ ActiveX controls and plug-ns ~
T9] Alcus previDLsly Uniised ACtive: cantrols ta run wihout pron
©) Disable
@ Enable
9] Alow Scriptlets
© pisable
@ Enable
© Prompt
9] Automatic prompting for ActiveX controls
© osable
@ Enable
9] Binary and script behaviors
© adniristrator approved
©) Disable
© Enable @

21 Picrlase viddars s srimation on = sishnans et doas nck e 2

< I
*Takes effect after you restart Internet Explorer

Rgset custon sethings

Se si utilizza la versione di Internet Explorer 11 su Win 7/8 OS, si prega di seguire questa procedura:

> Da Win 7 o Windows 8 Aprire il Browser IE e selezionare "Strumenti -> Impostazioni Visualizzazione
Compatibilita "

>  Aggiungere l'indirizzo IP della telecamera nella compatibilita nella finestra che si apre e mostrata di

seguito.

>  Controllare tutte le opzioni di compatibilita. In particolare, selezionare I'opzione "Visualizza tutti i siti
Web in Visualizzazione Compatibilita"

Al termine dell'installazione dell’Active X verra visualizzata la schermata di accesso dove & possibile
selezionare il nome utente (di default: admin), la password (di default admin), il Tipo di Stream (Main Stream,
Sub Stream, Mobile Stream) e la Lingua.

r

Password

Login

User Login

UserNeme  [agmn |

Language English v

Reset

A questo punto selezionare Accesso per entrare nella schermata LIVE.

Setting Local Setting

'[P Camera!

Premere il pulsante destro del mouse per selezionare il flusso video (Main Stream, Sub Stream o Mobile
Stream) e per visualizzare il bitrate.

Show Bit Rate

Main Stream

Sub Stream

Mobile Stream

DS1093-597



1 GENERAL INFORMATION

Dear Customer,
Thank you for purchasing this product.

This quick start guide was written to help you set up the following URMET IP cameras rapidly and easily: Ref.
1093/143M2 - Ref. 1099/204.

Read this quick start guide which contains information for correct, safe use carefully before using the device.

Keep this guide at hand so that you can refer to it when needed.

1.1  WARNINGS

Electricity

Y VvV

Before connecting to electrical outlet, verify the electrical specifications of the device are suitable for the
available power source.

We suggest to connect the device to electrical outlet via a switch disconnector.

In case of misfunctioning, disconnect electrical power from the general switch.

Use only the provided power supply.

Safety precautions

>

Y VY

Do not expose the device to rain or humidity and do not insert any solid or liquid object in it to prevent the risk of
fire or electrocution. In these events disconnect the device from the electrical outlet and call technical
assistance to check it.

Do not open the device. Any repair must be made by qualified personnel or by calling the nearest authorized
technical assistance center.

Keep the device away from children to prevent any, even involuntary, damaging.

Do not touch the device with wet hands as it might cause electrical shock or mechanical damages.

If the device falls down while working or if the salesbox is damaged, do not continue using it. If usage is
continued under such circumstances electrical shocks might take place. Contact the authorized retailer or
installer.

Installation precautions

VVVYVY VYV

\4

Y VY

Do not install the camera in places with possible exposure to rain or humidity without the proper protective case.
Do not point the camera directly to sunlight or other intense sources of light, even when turned off. The subject
of recording must not be against the light.

Do not point the camera against reflective objects.

Some light conditions (such as fluorescent color) can affect the recorded colors.

Use AUTO-IRIS lens when operating the camera in changing light environments.

Do not use this device on any unstable support such as lurching or sloping table to prevent the device from
falling and be damaged.

If water or any other material should penetrate the camera, stop using it as it might cause fire or electrical shock
and contact the authorized retailer or installer.

Do not cover the device with any cloth while using to prevent deformation of the external part and inner
components heating which might provoke fire, electrical shock or mechanical damages.

Do not put magnets or magnetized objects close to the device to prevent functional anomalies.

Do not use this device in presence of smoke, steam, humidity, dust or intense vibrations.

Do not use the device shortly after moving it from warm to cold environment and vice versa. After moving the
device wait three hours before using it: this time is necessary for the device to adapt to the new environment
(temperature, humidity, etc.).

Usage precautions

» Check the device is not damaged after removing the packaging.

»  Check the working environment is not too humid and the temperature is within the indicated range.

» Do not point the camera against sunlight to prevent sensor damages.

Device cleaning

» Use a dry cloth to remove dust and dirt from the device.

» If dirt cannot be removed with a dry cloth, use a humid cloth and a neutral cleanser.

» Do not use spray cleanser for device cleaning. Do not use volatile liquids such as gasoline, alcohol, solvents
etc. or chemical treated cloth to clean the device to prevent deformations, damages or scars on the finishing
paint.

» Disconnect the device from the electrical outlet before cleaning.

Video recording

» This device is not designed as a burglar system but mainly to transmit and record video images. URMET S.p.A.
is not in any way responsible for loss or damages of the user consequent to theft.

» Before using the device, record a demo video to verify the correct functionality of this feature. URMET S.p.A. is
not in any way responsible for loss of recorded data consequent to wrong setting or usage, device
misfunctioning or failure.

» This device is composed by electronic precision components. Do not hit the device while recording as it might

affect the video.
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Privacy and Copyright
» The IP camera is designed for surveillance systems. Video recording is subject to the laws applicable to the
Country where used.lt is forbidden to record images with Copyright.
» The User is responsible to check and respect all local laws and norms for video signal recording. The
manufacturer is NOT in any way liable for any usage of the product which might result not compliant to the
relevant norms.

Firmware upgrade
> Refer to URMET S.p.A. Customer Service Technical Assistance periodically to check availability of firmware
upgrades.

Network configquration
> Camera default setting is DHCP mode. If the network does not support dynamic addressing (DHCP), the device
will automatically switch to factory IP 192.168.1.168. Use Urmet “Easy Tool’ software to modify the IP address
and other network settings to prevent any conflict with other devices on the network.

Network connections
> When connecting a PC (using Software Client or Browser), any video channel on the PC will be using “unicast”
connection (TCP, RTP, UDP).

> The device can support up to 5 “unicast” connections so it is possible to show the video on maximum 5 remote
devices (PC or smartphone) at the same time depending on the available network band.

INSTALLATION REF. 1093/143M2

Make sure that no units are powered before starting the installation procedure.

Position the bracket to frame the required picture and fix it to the wall or other flat surface.
Connect the LAN cable from IP camera to switch or PC.

Power the camera.

INSTALLATION REF. 1099/204

Make sure that no units are powered before starting the installation procedure.

Identify the suitable position for shooting the selected images (the camera is put inside the PIR case and the images
are shot though the tiny hole on the front part).

In order to remove the sensor cover, unscrew and press on the fixing snap.

Identify the internal predispositions to fix the device and make the correct hole.

Once the device is fixed, put the cover on the base, screw and lock it.

Connect the LAN cable from IP camera to switch or PC.

Power the camera.
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4

IP CAMERA CONFIGURATIONS

The camera must be configured for the home or office network after it has been powered.
It is advisable to install and configure one camera at a time if you are installing multiple cameras on the same network.

4.1

CONNECTION TO IP NETWORK WITH DHCP SERVICE

For Quick installation about IP camera with dynamic host configuration (DHCP) on the network will be assigned an IP
address automatically. IF DHCP Service is not supported, the default IP Address of IP Camera will be 192.168.1.168.

Here follow the steps for the IP Camera first installation:

1. Install the Software “Easy Tool’ provided by CD and follow the installation instructions displayed at monitor.

2. Launch the “Easy Tool’ Software, selecting
Subnet Mask, Gateway, and MAC Address for each IP Camera detected in LAN, as shown in picture below. In
order to display Firmware Version it is hecessary to insert correct username and password

i EasyTool.exe

it will be displayed automatically IP Address,

0 EasyTool - o
Username: | admn Password: | ssaes = ok EMR  Epc @D
Network
O nu.... Device Type il Submask Gateway Channel  Frmware Version Device Status
1 Urmet IPC 1080P 192168141  255.255.255.0  192.168.1.1 1 1.1.6:20151130 No Action LD Lo TR TETE: ©
2 Urmet 1PC 1080P 102.168.1.13  255.255.255.0  102.168.1.1 1 1.1.6-20151130 No Action e § .0 .0 .0
3 Urmet IPC 1080P 0 192.168.1.194 255.255.255.0  192.168.1.1 1 1.1.6:20151130 No Action

<

Submask

Gateway

Right-click to select the video preview, open the browser operation!

use the Submask and Gateway of PC

Restore Network Configure

Refiesh List

[ e )

0o

Modify Network

Reboot

Restore to default

Upgrade

sync Time

If the searched IP address and PC IP address are not in the same network segment, user may modify IP
address, subnet mask, and other parameters of IP camera by using Easy Tool software.

First select the device to modify IP address and then input new IP address, subnet mask, gateway (subnet
mask and gateway can be inherited by PC) and username/password. Click Modify Network to change IP
address of the device.
*IMPORTANT NOTE
Default IP of IP camera is “192.168.1.168”, username is “admin”, password is “admin”, media port number is
“6066” and command port “6060”.

3. After detected IP Camera,push right button of the mouse and click “open in IE”, and will be opened a Web
Page. If the installation of an ActiveX component is required, follow these steps.
Before connecting the PC you need to configure |E protection as follows:

From Internet Explorer Menu select Tools -> Internet Options -> Security or Protection (depending

on different Internet Explorer versions)

“Properties — Internet Protection” window will be displayed. Select “Safe websites”.

>

>
>
>

Click “Websites...”.

Input camera IP address in “Add website to area” and press “Add”.

%Please note
Do not thick “Request server check (https:) for all area websites”.

Y VYV

\4
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Press “OK” or “Close”.
Select “Customized Level’ and check:

o “Enabled” or “Ask
confirmation” is selected for
“Initialize and run ActiveX
control script not marked as
safe”

o ‘“Enabled” or “Ask
confirmation” is selected for
“Download ActiveX control
without electronic signature’

Press “OK” to confirm and close Internet
Options menu.

Install Active X from Internet Explorer.

General | Security | Privacy | Content || Connections | Programs | Advanced

o

Restricted
sites

Select & zone to view or change security settings.

@ @ v

Internet  Local intranet  Trusted stes

@

Security level for this zone

Internet

This zone is for Internet websites,
excepk those listed in trusted and
restricted 2ones,

Custom
Custom settings.
~Ta change the settings, click Custom level,
- To use the recommended settings, click Default level.

Custom level.. Default level
Reset all zones to default level

f ﬂgﬁ! Security Settings - Internet Zone

X
Settings

x
T Al previously urused ActiveX corkrols t run without pran
© Disable
@ Enatle
@) Allow Scriptlets
O Disable
® Enable
O Prompt
|#] Automatic prompting For Activeit contrals
© Disable
@ Enatle
&) Binary and seript behaviors
© Adinistrator approved
O Disable
® Enable
41 Pinlans wiran snd animatinn on =

<

*Takes effect after you restart Internet Explorer

~

mhriane that dnac ook e

Rieset custom settings

= — ) e




%Please note
Procedure for Internet Explorer 11 on Win 7/8 OS:
»  Using Win 7 or Win 8 open IE Browser and select Tools -> Settings Compatibility View"
» Add camera IP address in the pop up window.
» Check all compatibility options. Select "Display all websites in Compatibility view” option.
4. At the end of Active X installation the login screen will be displayed where it is possible to select the Username
(Default: admin), Password (Default: admin), Stream Type (Main Stream, Sub Stream, Mobile Stream) and
Language.

User Login

User Name admin

Password

SteamType  |MainStream v/
Language English b

Login Reset

5. Select “Login” in order to enter in LIVE screen.

6. Press right mouse button to select the stream to display (Main Stream, Sub Stream or Mobile Stream) and to
show bitrate.
Show Bit Rate

Main Stream

Sub Stream

Mobile Stream
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1 GENERELLE INFORMATIONEN

Sehr geehrte Kunden
Wir bedanken uns, dass Sie dieses Produkt gekauft haben.

Das vorliegende Dokument ist eine Schnellanleitung, die es ermdglicht die folgenden IP Kameras des Unternehmens URMET
S.p.A:. Typ 1093/143M2 — Typ 1099/204 unter Funktion zu stellen.

Bitte lesen Sie sich vor Inbetriebnahme des Geréts die vorliegende Gebrauchsanleitung durch. Sie beschreibt den
sachgemaBen und sicheren Betrieb des Geréats. Heben Sie diese Gebrauchsanleitung sorgféltig und an einem leicht
zugéanglichen Ort auf, damit Sie sie bei Bedarf umgehend konsultieren zu kénnen.

1.1  WARNUNGEN
Versorgung

» Prifen Sie die Netzspannung, bevor Sie das Netzteil anschlieBen.

» Installieren Sie einen passenden Schutzschalter und Sicherung vor den Geréten.

> Im Falle einer Fehlfunktion schalten Sie den Strom am Schutzschalter aus.

> Verwenden Sie nur das Netzteil, das fiir die Stromversorgung des Gerates mitgeliefert wurde.

Sicherheitshinweise

» Halten Sie das Gerat von Regen und Feuchtigkeit fern um einen Brand oder einen elektrischen Schlag zu
verhindern. Lassen Sie kein Material (fest oder flissig) in das Gerateinnere gelangen. Wenn dies versehentlich
passiert, trennen Sie das Gerat vom Netz und lassen Sie es durch einen Fachmann Gberprifen.

» Offnen Sie niemals das Gerat. Nehmen Sie in jedem Fall Kontakt mit einer Fachfirma auf um das Gerat
reparieren zu lassen.

» Halten Sie das Gerat von Kindern fern um eine versehentliche Beschadigung zu vermeiden.

» Berlhren Sie das Gerat nicht mit nassen Handen damit Sie keinen elektrischen Schlag bekommen oder
mechanische Schaden verursachen.

» Benutzen Sie das Geréat nicht wenn es heruntergefallen oder das Gehause beschéadigt ist. Es besteht die
Gefahr eines Stromschlags wenn Sie das Gerét in einem solchen Zustand benutzen. Nehmen Sie Kontakt mit
dem Handler oder einer Fachfirma auf.

SicherheitsmaBnahmen bei der Installation

» Die Kamera sollte nicht ungeschiitzt wechselnden Wetterverhaltnissen (z.B. Regen) ausgesetzt werden. Nutzen
Sie hierflr vorgesehene AuBengehause.

» Vermeiden Sie die Ausrichtung der Linse zu direkter Sonneneinstrahlung oder intensiven Lichtquellen, auch
wenn die Kamera ausgeschaltet ist. Der Gegenstand benétigt keine Hintergrundbeleuchtung.

» Richten Sie die Kamera nicht auf reflektierende Objekte oder Spiegel.

» Einige Lichtsysteme (z.B. farbige Leuchtstoffréhren) kénnen die Farben verfalschen.

» Verwenden Sie eine AUTO-IRIS Linse wenn die Kamera in einer Umgebung mit wechselnden
Lichtverhéltnissen verwendet wird.

» Stellen Sie das Gerat nicht auf einer instabilen Unterlage auf, wie z.B. wackelnden oder schragen Tischen. Das
Gerat konnte herabfallen und Verletzungen verursachen oder mechanisch beschadigt werden.

» Benutzen Sie das Gerat nicht weiter wenn Wasser oder andere Substanzen in das Gerateinnere gelangt sind.
Es besteht Brandgefahr und die Gefahr eines elektrischen Schlags. Nehmen Sie Kontakt mit dem Handler oder
einer Fachfirma auf. ;

» Decken Sie das Gerat im Betrieb nicht mit einem Tuch ab um ein Uberhitzen und eine Deformation des
Gehauses und des Gerédts zu vermeiden: es besteht Brandgefahr, Gefahr eines elektrischen Schlags oder
mechanischer Fehlfunktion.

» Halten Sie Magnete und magnetische Objekte vom Gerat fern um Fehlfunktionen zu vermeiden.

» Benutzen Sie das Gerat nicht bei Rauch, Dampf, Feuchtigkeit, Staub oder intensiven Vibrationen.

» Warten Sie mit dem Einschalten des Geréates nach einem Transport von einem kalten an einen warmen Ort und
umgekehrt. Warten Sie ungefahr drei Stunden um das Gerat an die neue Umgebung (Temperatur, Feuchtigkeit
etc.) anzupassen.

BenutzungsmaBnahmen

> L:Jberprl'ern Sie die Verpackung und den Verpackungsinhalt auf erkennbare Schaden.

» Uberpriifen Sie, dass die Umgebungstemperatur im angegebenen Bereich ist und dass die Umgebung nicht
feucht ist.

» Richten Sie die Kamera nicht in die Sonne um eine Beschéadigung der CMOS-Sensors zu verhindern.

Reinigung des Gerétes

» Reinigen Sie die Oberflache mit einem trockenen, weichen Tuch um Staub und Verschmutzungen zu entfernen.

» Befeuchten Sie das Tuch mit einem neutralen Reinigungsmittel wenn der Schmutz nicht mit einem trockenen
Tuch entfernt werden kann.

» Benutzen Sie keine FlUssigkeiten (wie Benzin, Alkohol, L&sungsmittel, etc.) oder chemisch behandelte
Putzlappen um Verformungen, Zerstérung oder Kratzer im Lack zu verhindern.

» Trennen Sie das Gerat vor der Reinigung oder Wartungsarbeiten von der Stromversorgung.
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Aufnahmen Bilder

» Dieses Gerat ist nicht als Diebstahlsicherung ausgelegt, sondern zum Aufzeichnen von Bildern. Daher kénnen
die Unternehmen Grothe GmbH und URMET S.p.A., sollte der Benutzer Opfer eines Diebstahls werden, fiir
daraus folgende Verluste oder Schaden nicht haftbar gemacht werden.

> Fihren Sie eine Probeaufzeichnung durch, bevor das Gerét eingesetzt wird um zu dberprifen, ob der Vorgang
korrekt erfolgt. Beachten Sie, dass, sollte der Benutzer aufgrund einer fehlerhaften Uberwachungseinstellung,
Verwendung, unsachgemaBen Betriebs oder Funktionsstérungen des Geréts Verluste oder Schaden erleiden,
die Unternehmen Grothe GmbH und URMET S.p.A. nicht flir den eventuellen Verlust der gespeicherten Daten
als haftbar betrachtet werden kénnen.

» Dieses Geréat enthélt elektronische Prazisionskomponenten. Um die korrekte Aufzeichnung der Bilder zu
garantieren, wahrend dieses Vorgangs keinen Schlagen oder StdBen aussetzen.

Datenschutz und Copyright

» Die IP Kamera ist ein Gerat fir CCTV-Systeme. Die Aufzeichnung der Bilder unterliegt den geltenden
Bestimmungen im Benutzungsland. AuBerdem ist die Aufzeichnung von durch Copyright geschitzten Bildern
untersagt.

> Die Benutzer des Produktes sind fir die Kontrolle und die Einhaltung aller Normen und der ortlichen
Vorschriften bezuglich der Uberwachung und Aufzeichnung von Videosignalen verantwortlich. Der Hersteller
kann nicht fir einen Einsatz des Produktes haftbar gemacht werden, der nicht mit den geltenden
Bestimmungen Ubereinstimmt.

Aktualisierung der Firmware

» Es wird empfohlen, regelmaBig die Website http://www.urmet.com unter dem entsprechenden Abschnitt zu
konsultieren, um das Vorliegen eventueller Software-Aktualisierungen zu Uberpriifen.

Die Konfiquration des Netwerkes
» Die Kamera ist im DHCP Modus eingerichtet. Falls das Netzwerk bei dem die Kamera eingebunden wird, nicht

DHCP fahig ist, startet die Kamera automatisch mit der IP-Adresse IP 192.168.1.168. Mit Hilfe der Software
Urmet " Easy Tool " kann die Kamera im Netzwerk erfasst und danach konfiguriert werden.

Netzwerkverbindungen
»  Wird die Netzwerkkamera mit einem Fern-PC betrieben (bei Nutzung der Software oder des Internet Explorers),
beachten Sie bitte, dass alle Videokanéle (Videobildstréme), die von einem PC dargestellt werden, je einer
“Unicast”™Verbindung (TCP, RTP, UDP) entsprechen.
» Das Geréat kann bis zu 5 “Unicast” Verbindungen unterstitzen, z.B. kann es den Videostream von bis zu 5
fernen PC-Stationen anzeigen.

INSTALLATION TYP. 1093/143M2

Sicherstellen das kein Gerat mit einer Spannung versorgt ist, bevor der Installationsprozess gestartet wird.
Montage der Kamera an der Wand oder einer anderen Ebenen Oberfléache.

Das LAN-Kabel der Kamera mit einen Switch oder PC verbinden.

Die Kamera mit Spannung versorgen.

INSTALLATION TYP. 1099/204

Stellen Sie vor der Installation sicher, dass alle anzuschlieBenden Einheiten nicht versorgt werden.

Wiéhlen Sie die geeignetste Position fir die Vorrichtung zum Aufnehmen der gewéhlten Bilder (die Kamera ist im
Inneren des Detektors positioniert und die Bilder werden Uber die kleine Offnung auf der Vorderseite
aufgenommen).

Sobald die Positionierung festgelegt wurde, die Abdeckung des Detektors entfernen, indem die Schraube unter
diesem geldst und auf den Haltezahn gedriickt wird.

Verwenden Sie die Einschnitte auf dem inneren Teil des Gehduses zum Befestigen der Vorrichtung und bringen Sie
an jeder davon eine fiir die verwendete Verankerung geeignete Offnung an.

Verbinden Sie, sobald die Vorrichtung fest an der Auflagefldche angebracht ist, die beiden Teile und achten Sie
dabei darauf, den zuvor zum Offnen verwendeten Zapfen einrasten zu lassen und die Schraube wieder anzuziehen.
Das LAN-Kabel der Kamera mit einen Switch oder PC verbinden.

Die Kamera mit Strom versorgen.
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4 IP-KONFIGURATIONEN DER AUFNAHMEEINHEIT

Nachdem die Kamera mit Strom versorgt wurde, muss diese in ihnrem Haus- oder Blronetz konfiguriert werden.
Sollten mehrere Kameras in demselben Netz zu installieren sein, wird empfohlen, jeweils eine Kamera zu installieren
und zu konfigurieren.

4.1 ANSCHLUSS IM IP-NETZ MIT DHCP-SERVICE

Zur schnellen Installation der Kamera im Netz mit automatischer Adresszuweisung (DHCP) wird der IP-Kamera
automatisch eine IP-Adresse zugewiesen. Sollte die automatische Adresszuweisung (DHCP) nicht erfolgen, ist die
statische Standard-IP-Adresse 192.168.1.168.

Im Anschluss die zur ersten Installation der IP-Kamera notwendigen Schritte:
1. Installieren Sie die im Lieferumfang enthaltene Software “Easy Tool” auf der CD und befolgen Sie die auf dem
Monitor eingeblendeten Anweisungen.

2. Nach dem Start der Software “Easy Tool’ werden durch Auswahl von #ih EasyTool.exe automatisch die IP-
Adresse, die Subnet Mask, das Gateway und die MAC-Adresse jeder im jeweiligen LAN aktiven IP-Kamera
eingeblendet, wie im Anschluss dargestellt. Um die Version der Firmware anzeigen zu kénnen, mussen
Username und Password korrekt eingegeben werden.

0 EasyTool = =
Username: | admin Password: | ssses Login [VIDVR  [VINVR ~rc P
Network
CINu..  Device Type MAC P Submask Gateway Channel  Fimware Version  Device Status
1 UrmetIPC1080P  DCi07:00:12:23:34  192.168.1.11  255.255.255.0  192.168.1.1 1 1.1.6-20151130 Ho Action Interface | e El el
2 Urmet PC1080P  DC:O7:16:63:43:A7  102.168.1.13  255.255.255.0  102.168.1.1 1 1.1.6-20151130 No Action e 0 .0 .0 .0
3 Urmet PC1080P  DC:07:16:66:75:C0 192.168.1.194  255.255.255.0  102.168.1.1 1 1.1.6-20151130 Ho Action
submask [ 0 .0 .0
Gatewsy | 0 . 0 .0 .0
[¥luse the Submask and Gateway of PC
Modify Network
Reboot
Restore to default
Restore Network Configure
Upgrade
Sync Time
Refresh Lt
< >

Right-click to select the video preview, open the browser operation!

Befinden sich die gesuchte IP-Adresse und die IP-Adresse des PC nicht in demselben Netz, kann der Benutzer
die IP-Adresse, die Subnet Mask und andere Parameter der IP-Kamer unter Einsatz der Software Easy Tool
andern.

Zuerst das Gerat auswahlen, um die IP-Adresse zu dndern und anschlieBend die neue IP-Adresse, die Subnet
Mask, das Gateway (Subnet Mask und Gateway kénnen vom PC Ubernommen werden) und
Username/Password eingeben. Netzwerk andern betatigen, um die IP-Adresse des Gerats zu andern.

%BEACHTEN
Die statische Standard-IP-Adresse der IP-Kamera ist “192.168.1.168”, der Standard-Username sowie das
Standard-Password lauten “admin”, die Media-Port-Nummer ist “6066” und der Steuerport “6060”.

3. Nachdem die IP-Kamera erfasst wurde, die rechte Maustaste betatigen und “open in IE” (in IE o6ffnen)
auswahlen und es wird eine Webseite auf IE eingeblendet.
Sollte die Installation eines ActiveX-Steuerelements verlangt werden, Uberprifen, ob dies auf die im Anschluss
beschriebene Art und Weise erfolgt.
Vor der Herstellung der Verbindung mit dem PC muss die Schutzkonfiguration von IE anhand des folgenden
Vorgangs erfolgen:

> Aus dem Menl von Internet Explorer Extras -> Internetoptionen -> Sicherheit/Schutz (je nach
Internet Explorer-Version) auswahlen

>  Es erscheint die Ansicht "Sicherheit - Sicherheitszone”. Wahlen Sie den Bereich “Vertrauenswiirdige
Sites”.

> Klicken Sie auf “Sites”.

>  Flgen Sie die IP-Adresse des Geréats im Feld “Diese Website zur Zone hinzufligen” hinzu und
klicken Sie auf die Schaltflache "Hinzufligen".
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%BEACHTEN
Nicht den Punkt "Fur Sites dieser Zone ist eine Serveriiberpriifung (https:) erforderlich” aktivieren.

> "OK" oder "SchlieBen" anklicken.
>  Wahlen Sie "Stufe anpassen’ und liberprifen, ob die folgenden Punkte:

o "ActiveX-Steuerelemente initialisieren und ausfiihren, die nicht sicher sind’ mit
“Aktivieren” oder “Bestéatigen” ausgewahlt ist sowie

o “Download von unsignierten ActiveX-Steuerelementen” mit “Aktivieren” oder
“Bestatigen”

> Durch Betatigen von "OK" wiederholt bestatigen und den Modus Internetoptionen verlassen.

> Die Installation der ActiveX-Steuerelemente von Internet Explorer aus vornehmen.

o O T —

General | Security |privacy || Content | Connections | Programs | Advanced Settings

3] Activex controls and plug-ns -~
Sellct & 20ne to view of change Security settings. T Al previusly unused ActiveX controls ta run withaut pror

- . = O Disable
@ l!]. / @ @ Enatle
= v i
@) Allow Scriptlets
Internet Local intranet  Trusted sites Rezlttrltsted O Disable
& Enable
© Promet

This zone is for Internet websites, @ Automatic prompting For ActiveX controls
except those listed in trusted and " © Disable

restricted zanes.
® Enable

|#] Binary and script behaviors
© Administrator approved

Internet

Seaurity level for this zone

O Disable
Custom @ Enable 3
Custom settings. 41 Pinians i and animstinn on = wshans that dnas ok 1ies
- Ta change the sektings, chck Custom level, < >
- To use the recommended sattings, cick Default level. WTakes effect after you restart Intemet Explorer
Riesst custom settings
IReset o T I Reset...
Custom level. . Default level
Rieset all zones to default level

%BEACHTEN
Wird die Version Internet Explorer 11 auf Win 7/8 OS verwendet, bitte wie folgt vorgehen:

> Von Win 7 oder Windows 8 aus den Browser von IE 6ffnen und "Extras-> Einstellungen der
Kompatibilitdtsansicht" auswahlen

> Die IP-Adresse der Kamera in die Kompatibilitdt im sich 6ffnenden und im Anschluss abgebildeten
Fenster hinzufgen.

> Alle Kompatibilititsoptionen  kontrollieren. Insbesondere die Option "Alle Websites in
Kompatibilitdtsansicht anzeigen" auswéhlen

4. Nach der Installation der ActiveX-Steuerelemente wird die Zugangsansicht eingeblendet, von der aus der
Benutzername (Standard: admin), das Passwort (Standard: admin), der Stream-Typ (Main Stream, Sub Stream,
Mobile Stream) und die Sprache ausgewahit werden kénnen.

User Login
User Name admin
Password
steamType  [MainSteam V|
Language English v
Login Reset

5. Nun Zugang auswéhlen, um in die Ansicht LIVE zu gelangen.
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6. Die rechte Maustaste betatigen, um den Videofluss (Main Stream, Sub Stream oder Mobile Stream)
auszuwahlen und die Bitrate anzuzeigen.

Show Bit Rate

Main Stream

Sub Stream

Mobile Stream

DS1093-597
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1 GENERALITES

Cher Client,
Merci d’avoir fait I'acquisition de ce produit.

Ce guide de démarrage rapide a été rédigé afin de vous aider a installer rapidement et aisément les caméras IP URMET
suivantes : Réf. 1093/143M2 — Réf.1099/204.

Lisez soigneusement ce guide de démarrage rapide qui contient toutes les informations qui vous permettront une
utilisation correct et sure avant d'utiliser le matériel.

Conservez ce guide a portée de la main de fagon a pouvoir le consulter en cas de besoin

1.1 SECURITE

Electricité
» Avant de connecter le matériel a une prise électrique, assurez-vous que les caractéristiques électriques
de celui-ci correspondent a la source d’alimentation disponible.
» Nous vous conseillons de connecter le matériel a une prise électrique par I'intermédiaire d’un interrupteur
d’isolement.
» En cas de dysfonctionnement, couper I'alimentation électrique a partir du commutateur général.
»  Utiliser seulement le bloc d’alimentation fourni.

Mesures de sécurité

» Protéger le matériel de la pluie ou de I'humidité et ne rien introduire a l'intérieur (solide ou liquide) afin
d’empécher tout risque de départ de feu ou d’électrocution. Dans le cas ou cela se produirait, débrancher
le matériel de la prise électrique et faites appel au service technique afin de procéder a des vérifications.

» Ne pas ouvrir le matériel. Toute réparation doit étre exécutée par un personnel qualifié ou en appelant le
service technique agrée le plus proche.

» Tenir le matériel éloigné des enfants, afin d’empécher tous dommages accidentels.

» Ne pas toucher le matériel avec des mains humides afin d’éviter tout risque d’électrocution ou dommage
mécanique

»  Si le matériel vient a tomber ou si 'emballage est endommagé, cessez de I'utiliser. Continuer a I'utiliser
dans de telles circonstances pourrait induire des chocs électriques. Contacter le distributeur ou
linstallateur agréé.

Précautions d’installation

» Ne pas installer la caméra sans un boftier de protection approprié dans des endroits qui seraient soumis a
la pluie ou a I'humidité.

» Ne pas pointer la caméra directement vers la lumiére du soleil ou d’autres sources de lumiére intense,
méme quand elle est hors service. L'objet de I'enregistrement ne doit pas se situer en contre-jour.

» Ne pas pointer la caméra vers des objets réfléchissants.

» Certaines conditions de lumiére (comme les éclairages fluorescents) peuvent perturber les couleurs
enregistrées.

»  Utiliser un objectif AUTO—-IRIS lorsque la caméra fonctionne dans des environnements de lumiére qui
changent.

» Ne pas utiliser ce matériel sur une surface instable telle qu'une table branlante ou inclinée de fagon a
empécher le matériel de tomber en entrainant des dommages.

» Side I'eau ou tout autre matériau venait a pénétrer dans la caméra, cesser de I'utiliser ; cela pourrait étre
a l'origine d’un départ de feu ou d’une électrocution et contacter dans ce cas le distributeur ou l'installateur
agréé.

» Ne pas couvrir d’'un tissu le matériel en cours de fonctionnement afin d’empécher une déformation du
boftier extérieur et une surchauffe des composants internes ; cela pourrait étre a I'origine d’'un départ de
feu, d’une électrocution ou de dommages mécaniques.

» Tenir le matériel éloigné d’aimants ou d'objets magnétisés afin d'éviter toutes défaillances de
fonctionnement.

» Ne pas utiliser le matériel en présence de fumée, de vapeur, d’humidité, de poussiére ou de vibrations
intenses.

» Ne pas utiliser le matériel immédiatement apres I'avoir déplacé d’'un endroit chaud vers un endroit froid et
vice versa. Aprés avoir déplacé le matériel, attendre trois heures en moyenne avant de I'utiliser : ce laps
de temps permet au matériel de s’adapter a son nouvel environnement (température, humidité, etc.)

Précautions d’utilisation

»  Vérifier que le matériel n’est pas endommagé aprés I'avoir retiré de son emballage.

»  Vérifier que le milieu de travail n’est pas trop humide et que la température se situe a I'intérieur de la plage
indiquée.

» Ne pas pointer la caméra vers la lumiére du soleil afin de ne pas endommager le capteur.
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Nettoyage du matériel

Utiliser un tissu sec afin de retirer la poussiére et la saleté du matériel.

S’il n'est pas possible de retirer la saleté avec un tissu sec, utiliser un tissu humide et un agent de
nettoyage neutre.

Ne pas utiliser de produits aérosols afin de nettoyer le matériel. Ne pas utiliser de liquides volatils (tels que
de I'essence, de l'alcool, des solvants, etc.) ou des lingettes traitées chimiquement afin de nettoyer le
matériel afin d’éviter toute déformation, détérioration ou rayures de la peinture.

Déconnecter le matériel de la prise électrique avant de procéder a un nettoyage.

Enregistrement vidéo

Ce dispositif a été principalement congu afin de transmettre et enregistrer des images vidéo, et non pas
en tant qu'avertisseur d’effraction. URMET S.p.A. ne saurait étre tenu pour responsable de quelque fagcon
que ce soit des pertes ou des dommages consécutifs a un vol subi par un utilisateur.

Avant d'utiliser le matériel, enregistrer une vidéo de démonstration afin de vérifier que ses fonctionnalités
sont correctes. URMET S.p.A. ne saurait étre tenu pour responsable de quelque fagon que ce soit de la
perte de données enregistrées suite a une configuration ou a une utilisation erronée, a un
dysfonctionnement du matériel ou & une panne de celui-ci.

Ce matériel contient des composants électroniques de précision. Ne pas cogner le matériel tandis qu’il
enregistre, cela pourrait affecter la vidéo.

Vie privée et copyright

La caméra IP est congue pour des systémes de surveillance. Un enregistrement vidéo est soumis aux lois
en vigueur dans le pays ou le matériel est utilisé. Il est interdit d’enregistrer des images protégées par
copyright.

Les utilisateurs sont responsables du contréle et du respect de tous les réglements et régles locaux qui se
rapportent a I'enregistrement de signaux vidéo. URMET S.p.A. ne saurait étre tenu pour responsable de
quelque fagon que ce soit de toute utilisation du produit qui pourrait résulter du non-respect des normes
appropriées.

Mise a jour du micrologiciel
Veuillez consulter le service technique URMET S.p.A. afin de contréler périodiqguement la disponibilité des
mises & jour du micrologiciel.

Network configuration
Camera default setting is DHCP mode. If the network does not support dynamic addressing (DHCP), the

device will automatically switch to factory IP 192.168.1.168. Use Urmet “Easy Tool” software to modify the
IP address and other network settings to prevent any conflict with other devices on the network.

Configuration du réseau

La configuration par défaut de la caméra est le mode DHCP. Si le réseau ne prend pas en charge
I'adressage dynamique (DHCP), le matériel commutera automatiquement vers I'adresse IP 192.168.1.168
préréglée en usine. Utiliser le logiciel Urmet « Easy Tool » afin de modifier I'adresse IP et d'autres
parametres réseau pour éviter tout conflit avec d’autres matériels présents sur le réseau.

Connexions au réseau

Lors d’'une connexion & un PC (en utilisant un logiciel client ou un navigateur), tout canal vidéo sur le PC
utilisera une connexion de type « diffusion individuelle » (TCP, RTP, UDP).

Le matériel peut supporter jusqu’a 5 connexions de type « diffusion individuelle », aussi est-il possible de
visionner en méme temps la vidéo sur 5 matériels distants au maximum (PC ou smartphone), selon la
largeur de bande disponible du réseau.

INSTALLATION REF. 1093/143M2

Assurez-vous qu’aucun produit ne soit alimenté avant de commencer l'installation

Positionnez I'étrier de fagon a obtenir 'image souhaitée et fixez le au mur ou sur une surface plane
Connecter le cable réseau de la caméra a un switch ou a un PC

Mettre la caméra sous tension

INSTALLATION REF. 1099/204

Avant de procéder a l'installation, s’assurer qu’aucune des unités a brancher n’est alimentée.

Choisir la position la plus appropriée pour que le dispositif puisse filmer les images souhaitées (la caméra est
positionnée a l'intérieur du détecteur et les images sont filmées a travers le petit orifice présent sur la face avant).

Apres avoir établi la position, déposer le couvercle du détecteur en dévissant la vis située sous le détecteur, puis
appuyer sur la dent de fixation.
A l'aide des gravures présentes sur la partie intérieure du boitier, fixer le dispositif en pratiquant sur chacune de
celles-ci un trou de dimensions appropriées au type d'ancrage utilisé.
Apres avoir solidement fixé le dispositif a la surface d’appui, unir les deux parties en veillant a faire déclencher le
pivot précédemment utilisé pour 'ouverture, puis revisser la vis.

Connecter le cable réseau de la caméra a un switch ou a un PC
Alimenter la caméra.
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4 CONFIGURATIONS IP DE L’UNITE DE FILMAGE

Aprés avoir mis la caméra sous tension, il est nécessaire de la configurer sur le réseau de la maison ou du bureau.
En présence de plusieurs caméras sur un méme réseau, il est conseillé de les installer et configurer une a la fois.

4.1

CONNEXION SUR RESEAU IP AVEC SERVICE DHCP

Pour linstallation rapide de la caméra sur un réseau avec service d'adressage automatique (DHCP), une adresse IP
sera automatiquement attribuée a la caméra IP. En I'absence d’adressage automatique (DHCP), I'adresse IP statique
par défaut sera 192.168.1.168.

Pour la premiére installation de la caméra IP, procéder comme suit :

1.
2.

Installer le logiciel “Easy Toof” (livré de série sur CD) et suivre les instructions affichées a I'écran.

]
Lancer le logiciel “Easy Tool'. En sélectionnant 'ri' EasyTool.exe , le logiciel affichera automatiquement
I'adresse IP, le masque de sous-réseau, la passerelle et 'adresse MAC de chaque caméra IP active sur le LAN
courant (voir figure suivante). Pour afficher la version micrologicielle, il est nécessaire d’entrer correctement le
nom utilisateur et le mot de passe.

0 EasyTool = =
Username: | admn Password: | seeee oo T T e 5
Network
[CINu..  Device Type MAC P Submask Gateway Channel  Frmware Verson  Device Status
1 Urmet PC1080P  DC:07:00:12:23:34  192.168.1.11  255.255.255.0  102.168.1.1 1 1.1.6-20151130 Ho Action Interface |Lenovo USB Ethernet v
2 Urmet IPC1080P  DC:07:16: A7 192.168.1.13  255.255.255.0  192.168.1.1 1 11620151130 No Action S e
3 UrmetIPC1080P  DCi07:16:66:75:C0  192.168.1.194  255.255.255.0  192.168.1.1 1 1.1.6-20151130 1o Action

Submask 8.0 .6 .40

Gateway | 0 .0 .0 .0

[ use the Submask and Gateway of PC
Modify Network
Reboot
Restore to default
Restore Network Configure

Upgrade

Sync Time

Refiesh List

< >

Rightclick to select the video preview, open the browser operation!

Si 'adresse IP recherchée et I'adresse du PC ne se trouvent pas sur le méme réseau, I'utilisateur peut modifier
I'adresse IP, le masque de sous-réseau et d’'autres paramétres de la caméra IP, en utilisant le logiciel Easy
Tool.

Sélectionner d’abord le dispositif pour modifier I'adresse IP, puis entrer la nouvelle adresse IP, le masque de
sous-réseau, la passerelle (le masque de sous-réseau et la passerelle peuvent étre hérités du PC) et le nom
utilisateur/mot de passe. Appuyer sur Modifier Réseau pour modifier I'adresse IP du dispositif.

%N.B. :
L’adresse IP statique par défaut de la caméra IP est “192.168.1.168” ; le nom utilisateur par défaut est “admin” ;
le mot de passe par défaut est “admin” ; le numéro de port média est “6066” et le port de commande est “6060”.

Apres avoir détecté la caméra IP, appuyer sur la touche droite de la souris et sélectionner “ouvrir sur IE” (“open
in IE”) pour ouvrir une page Web sur IE.

S’il est nécessaire d’installer un composant ActiveX, s’assurer de procéder comme suit.
Avant d'effectuer la connexion avec le PC, il est nécessaire de procéder a la configuration de protection de IE,
en respectant la procédure suivante :

> Dans le menu d’Internet Explorer, sélectionner Outils -> Options Internet -> Sécurité ou Protection
(selon les versions d’Internet Explorer).

L'écran “Propriétés — Protection Internet” s'affichera. Sélectionner 'option “Sites de confiance”.
Cliquer sur “Sites...”.

Ajouter I'adresse IP du dispositif dans le champ “Ajouter ce site Web a la zone” et cliquer sur la
touche “Ajouter”.

%N.B. :
Ne pas sélectionner I'option “Demander vérification serveur(https:) pour tous les sites de la zone”.

>  Cliquer sur “OK” ou “Fermer”.

>  Sélectionner “Personnaliser le niveau” et vérifier que :
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o la rubrique “Exécuter les controles Active X non marqués comme sécurisés’ est
sélectionnée sur “Activer” ou “Demander confirmation” ;

o la rubrique “Télécharger les contréles Active X non signés” est sélectionnée sur
“Activer” ou “Demander confirmation”.

>  Confirmer a chaque fois en appuyant sur “OK” et quitter la modalité Options Internet.

> Procéder a I'installation de I'Active X depuis Internet Explorer.

1 e —)

Settings

]
79 Alow previously unused Activex controls to run without prom
© pisable
@ Enable
4] Allow Seriptlets
ek Lo pianot Tustod s Rosited S b
== @ Enable
Internet © prompe

This zone i For Intsmet webstes, @] Automatic prompting for ActiveX controls
except those listed in trusted and O Disable:
restricted zones,

@ Enable
@] Binary and seript behavicrs
admiristrator approve:

ble:

e

Security level for this zone.

Custom @®
Custorn settings. ) P iran snd it an 2 wshana tht dnee nnt e
- Ta shange the settings, click Custom level, ¢ | 2
- To use the recommended settings, click Default level.

*Takes effect after you restart Internet Explorer

Reset custom settings

Custom level Default lovel

Reset all 20nes to defaul level

%N.B. :
En cas d’utilisation de la version Internet Explorer 11 sur Windows 7/8 OS, procéder comme suit :
> Sur Win 7 ou Windows 8, ouvrir IE et sélectionner "Outils -> Paramétres d’affichage de
compatibilité".
> Ajouter I'adresse IP de la caméra dans la fenétre qui s’affiche (voir ci-dessous).

> Vérifier toutes les options de compatibilité. En particulier, sélectionner I'option "Afficher tous les sites
Web dans Affichage de compatibilité".

4. Au terme de l'installation de I'Active X, le logiciel affichera un écran d’acces permettant de sélectionner le nom
utilisateur (par défaut : admin), le mot de passe (par défaut : admin), le Type de Stream (Main Stream, Sub
Stream, Mobile Stream) et la Langue.

User Login
User Name admin
Password
steamType  [MainStreem |
Language English hd
Login Reset

5. A ce stade, sélectionner Accés pour accéder a I'écran LIVE.

6. Appuyer sur la touche droite de la souris pour sélectionner le flux vidéo (Main Stream, Sub Stream ou Mobile
Stream) et afficher le débit en bits (bitrate).

Show Bit Rate

Main Stream

Sub Stream

Mobile Stream
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DOCUMENTAZIONE / DOCUMENTATION /| DOKUMENTATION / DOCUMENTATION
ITALIANO
Guida rapida e manuale completo del dispositivo sono disponibili al seguente indirizzo:

Guida rapida e manuale completo sono altresi disponibili per il DOWNLOAD dal sito URMET nella sezione LIBRETTI DI
ISTRUZIONE.

1093/143M2 1099/204

ENGLISH
Quick guide and complete user manual of the product are available at the following link:

Quick guide and complete user manual of the product are also available for DOWNLOAD from the URMET website
under the section USER MANUALS.

DEUTSCH
Die Schnellanleitung, sowie die komplette Bedienungsanleitung stehen unter dem folgenden Link zur Verfligung:

Die Schnellanleitung, sowie die komplette Bedienungsanleitung stehen auBerdem im Bereich DOWNLOAD auf der
URMET Homepage in der Sektion USER MANUALS zur Verfligung (Die Webseite wird in Englisch dargestellt).

FRANCAIS
Le guide rapide et le manuel d'utilisation complet du produit sont disponibles sur le lien suivant:

Guide rapide et manuel d'utilisation complet du produit sont également disponibles en téléchargement (DOWNLOAD) a
partir du site Web URMET dans la section USER MANUALS (Le site web est en anglais).

1093/143M2 1099/204
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